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About Durametric
Durametric Software Inc. is comprised of software engineers and automotive enthusiasts alike. As 
automotive enthusiasts, we understand the value of solid, effective tools in the workshop. As engineers, 
we work hard to develop intuitive, comprehensive software and robust hardware to create an overall 
package that meets our customers’ high standards – and ours.

The Durametric tool for Porsche is a hardware and software-based tool. The software program installs 
and runs on your Microsoft Windows computer and manages communication between you and the car. 
The hardware consists of one or more cables that connect between your computer and the car and 
facilitates communications between the program and the car. With a primary focus on diagnostics, the 
tool provides communications with the various systems to read, display, and clear trouble codes, reset 
service reminders, activate system components, display and capture live values, and alter code settings.

Included in the Kit
Depending on the product kit you purchased, some or all of the following cables will be included with 
your package: standard interface cable, early-model adapter cable, 50’ extension cable, racecar adapter 
cable. We do not include a software installation CD with your order. You must download and install the 
Durametric software directly from the Durametric web site, www.durametric.com.

           Standard interface cable       Early-model adapter cable

          

                     50’ extension cable       Racecar adapter cable
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Product Variations
Durametric offers three varieties of diagnostic kits for Porsche: Enthusiast, Professional, and 
Professional Racing. With the exception of coding and command console features, all kits provide the 
same diagnostic capabilities across the same range of standard-production cars. The coding and 
command console features are available with the Professional kits only. Only the Professional Racing kit 
supports Porsche factory racecars in addition to standard-production cars.

 Enthusiast Kit: Intended for the private owner of Porsche, the Enthusiast kit comes complete 
with one USB-to-ODBII standard interface cable. If purchased, your kit might also include the 
early-model adapter cable with the nineteen-pin, early-model adapter cable. 

The Enthusiast kit is limited to use on three cars managed by VIN. Durametric enforces this limit 
by storing the car’s VIN in the memory of the cable. After you use the cable on three cars, it will 
only continue to function on those three cars.

 Professional Kit: Intended for the service repair shop, the complete Professional kit comes with 
one USB-to-ODBII standard interface cable, one 50’ extension cable, and one nineteen-pin, 
early-model adapter cable. Variations to this kit also exist. You can use the Professional version 
on an unlimited number of cars.

 Professional Racing Kit: Intended for service repair shops and Porsche racecar support teams, 
this kit supports all diagnosable, standard-production Porsche models and Porsche factory 
racecars. You can use this kit on an unlimited number of cars. This kit comes complete with one 
USB-to-ODBII standard interface cable; one 50’ extension cable; one nineteen pin, early-model 
adapter cable; and one racecar adapter cable.

How the Program Works
The completely redesigned Durametric program makes use of a new and innovative software platform. 
The new software platform has three main components: 1) the “Framework” 2) the “CAR files,” and 3) 
the “ECU files.”

The Framework is the core of the new software. It maintains control over all other components of the 
tool including the user interface and communication with the standard interface cable and car. The 
Framework gets information from the CAR files in order to reference control units associated with the 
many different Porsche models. It gets information from the ECU files so it can communicate effectively 
with those control units.

Each Porsche model comes equipped with a number of electronic control units. The CAR files are simple 
XML files that list each possible control unit in a given model. The Framework uses the CAR files to 
reference the Durametric ECU files.

The ECU files are XML files that contain control unit address information, unit ID and descriptions, 
possible fault codes and their descriptions, activation options, and other ECU-specific details. The 
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Framework uses the information in the ECU files to interact with the control unit. The Durametric user 
interface displays much of the information contained in the ECU file, such as available options and fault 
code descriptions.

With the introduction of this platform, Durametric can support more features on a greater number of 
control units at a faster pace of release.

Installation
The following sections will guide you through a successful installation of the Durametric software.

Check System Requirements
The following is a list of the minimum system requirements for the effective use of the tool. Check to be 
sure your system meets or exceeds these requirements and has the prerequisite software installed.

 Windows OS version 11, 10, 8, 7, Vista or XP. If using Windows 10 or 11, “S-mode” must be 
switched off. MacOS not supported.

 1 GB Memory (RAM) 

 1.8 GHz Pentium-class, dual-core processor or faster. ARM processor not supported.

 1 GB available hard disk space 

 Available USB 2.0 or 3.x port

 Available Internet connection and browser (for program installation and software updates)

 Screen resolution of 800x600 or greater 

 Microsoft® .NET Framework 3.5 sp1 (free download). In Windows 7, 8 and 10, enable this option
through Control Panel | Programs | Turn Windows features on or off.

 Adobe Acrobat Reader (for reading and printing documentation) 

Install the Software
After you install the necessary supporting software you can install the Durametric software.

1. Open your Internet browser and go to http://www.durametric.com.

2. Click Downloads.

3. Under the Software section, click Durametric Software program version 6.x.x.x link (where x.x.x.x
represents the current release) to install the software program. 

4. Run the installation EXE file to begin the program installation. 

5. If you see an Unknown Publisher or Open File Security Warning, click Run.
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6. The Durametric Setup Wizard screen appears.

7. Click Next to proceed with the Durametric Setup Wizard.

8. On the Completing the Durametric Setup Wizard screen, select to install the Device Driver and 
click Finish.

9. The Device Driver Installation Wizard screen appears.

10. Click Next and then Finish on the Device Driver Installation Wizard screen to complete the 
process.

Software installation is now complete.

Connect the Cable(s)
WARNING: Do NOT use a power inverter to power your computer when using Durametric. 

Depending upon the kit you ordered, you will have one, two, three, or four cables. Before starting the 
Durametric program, connect the tool to your car as follows:

1. Switch the car’s ignition to its accessory position. 

2. If the car is a 2005 model or newer, turn on the hazard lights (emergency flashers). This will help
keep the car’s CAN bus awake during diagnostics.

3. Connect your Durametric cable(s) to the car.

 If you are using only the Durametric USB-to-OBDII cable, connect this cable to the OBDII 
diagnostic port in your car.

 If you are working on a pre-1996 model year car, connect the round adapter cable to the 
round diagnostic port in the car and connect the Durametric USB-to-OBDII cable to the 
round adapter cable.

 If you purchased the 50’ extension cable, connect it directly to the car (or to the round 
adapter cable) and connect the USB-to-OBDII cable to the extension cable.

 If you are working on a Porsche factory racecar and have the Durametric cup adapter cable, 
connect it between the USB-to-OBDII cable and car or between the 50’ extension cable and 
the car. 

4. Connect the Durametric cable to the USB port on your computer.

5. Confirm a steady green LED at the OBD-end of the Durametric cable, that your computer 
recognizes the attached Durametric cable, and – with the first connection – the computer 
indicates the hardware is installed successfully.
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Using Durametric
Durametric is equipped with many of the same capabilities and features of the Porsche factory tools. 
The following sections guide you through the many features of the program to help you get the most 
from your tool.

Start the Program
Connect the cables before starting the program. To start the program after its initial installation double-
click the Durametric 6 desktop icon, or:

1. Click the Windows Start button.

2. Select  All Programs |Durametric 6.

Upon starting the program, you will see the Durametric logo screen(s) of the main program. 

Choose Vehicle
The first screen to appear after successful installation of the software is the Choose Vehicle dialog. Here 
you can choose a car based on make, model, series, and year. Alternatively, you can choose a specific 
control unit from the list of all supported control units found under the Individual Control Modules tab 
of the Choose Vehicle dialog.

Select a model or individual control unit from the Choose Vehicle dialog

Main User Interface
The main user interface now appears. When you select a model from the Choose Vehicle dialog, the 
program displays a list of supported control units in the left-hand pane. If you select a single control unit
from the Individual Control Modules tab of the Choose Vehicle dialog, the software displays only that 
control unit.
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Double-click a control unit in the left-hand pane to reveal available functions for that control unit. 
Alternatively, click the “+” sign next to any of the control units to reveal the same list of functions.

Select from supported control units in the left-hand pane of the main user interface.

Screen Layout
The Durametric screen displays several key points of information, including software version, selected 
model, status of the cable connection, and the control unit selected. 
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Menu options 

 File

o Start over – opens the Choose Vehicle dialog to select a different model

o Open work log – opens a Browse window for the selection of a previously-saved work 
log (see Work Log section for details)

o Open ECU file – opens a Browse window for the selection of a stand-alone ECU file. 
Used by Durametric technical staff for troubleshooting purposes.

o Print – sends the current view of data to the default printer

o Print setup – not currently supported

o Exit – closes the Durametric program

 Functions
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o Short test all modules– starts a check of all control units for fault codes

o Clear faults in all modules – used to clear all fault codes in all supported control units of 
the selected model

o Refresh current view – used to request updated fault codes are live data from a control 
unit

o Set workshop information – opens the Set Workshop Information dialog (see Set 
Workshop Information section for details)

 Tools

o Tool information – opens the Tool Information screen that provides cable type, cable 
status, cable serial number, and software / firmware version details

o Logging

 Logging enabled – enables logging for troubleshooting purposes

 Send log to Durametric – opens the Send Communications Log screen  (see Send
Log to Durametric section for details)

o Check for update – uses an available Internet connection to check for software updates 
(see Updating the Software section for details)

o Language – used to change the text of the user interface to one of many supported 
languages

 Help

o Documentation – opens this guide in PDF format

o Durametric WIKI – uses an available Internet connection to open the Durametric WIKI 
pages that cover car-specific troubleshooting information and more

o About – opens information about the program and the program version

Icons at the top of the Durametric user interface provide access to common functions. These include:

   New – opens the Choose Vehicle dialog to select a new vehicle

   Open –opens saved work logs
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   Print – print the current page

   Print Setup – not currently supported

  Refresh – refresh the current view

   Short test all units – runs a brief test of all control units in the car to check for fault codes

  Clear faults in all units – attempts to clear all fault codes in all control units of the car

Control Unit Functions
Each control unit supports one or more of several different functions. You can access these functions by 
expanding the list under each control unit. 

View of control unit functions 

In order of appearance, these functions include:
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Identification
The Identification function is available for each control unit and displays information such as part 
number and supplier name.

Information
You can find the Information function under control units that support this feature. This option displays 
information such as the VIN and assembly number.

Fault Codes/Shadow Fault Codes
Fault codes, shadow fault codes, their descriptions, and fault status information are included in the 
display when supported by the control unit. The codes displayed are the same codes used by the factory
tool and can be directly referenced in the factory service manual or other reputable repair manuals. 
Freeze frame details are included with supported engine control units. Freeze frame information 
includes various operating and environmental data taken at the time the fault appeared. You can use 
this information to aid in troubleshooting and to help resolve improper operation.

Control units store some faults for information-only purposes. In these cases, there is no repair action 
necessary. Durametric indicates the difference between actionable faults and information-only faults 
using two icons. The yellow circle icon with the exclamation point in the center indicates an information-
only fault. The red circle icon with the exclamation in the center indicates an actionable fault. Refer to 
your car’s service repair manual for more information on information-only faults.

    
Information-only fault indicator              Actionable fault indicator

Erase Fault Codes/Erase Shadow Fault Codes
To clear fault codes or shadow fault codes from the control unit’s memory, click on the Erase Fault 
Codes or Erase Shadow Fault Codes option, respectively, for the control unit selected. 

Alternatively, you can select to erase fault codes in all control units at once by selecting the Functions 
menu option and selecting Clear faults in all units. 

It is not possible to erase only one fault code. If faults remain after attempting to clear them, it indicates 
the problem(s) causing the condition still exists. For example, if the fault you see is “Electrical fault, 
oxygen sensor ahead of catalytic converter bank 2,” and you have not repaired the problem, you will not
be able to clear the fault.

Actual Values
With Actual Values, you can monitor live data values managed by the control unit. The available value 
options are predominantly the same as those available in the latest Porsche factory tool. In most cases, 
to view Actual Values you will need to start the car’s engine (when safe to do so) prior to connecting the 
Durametric cable and opening the program.

2/11/2025 ©Durametric Software Inc. Page 12 of 30



Upon selection of a value, the data automatically appears in graph and/or in digital format as seen 
below. You can choose to view the data in graph format, digital format, or both, by selecting your 
preference on the Options tab.

  
Viewing live data in Actual Values

To use actual values:

1. Select a control unit from the left-hand pane.

2. Click Actual Values (found on supported control units only).

3. In the right-hand pane under the Available Actual Values tab, select a listed value. Live values 
will appear in graph and digital format automatically.

Note: Avoid selecting more values than needed. The Actual Values process is very resource intensive for 
the control unit and the computer running the program. Selecting more options than necessary can 
seriously degrade program performance. For this reason, the program is limited to the selection of ten 
values. Also, note that sample rates vary by control unit. The newest control units sample much faster 
than earlier versions. Faster sampling rates require more computer resources.

There are three tabs found on the Actual Values screen:

 Available Actual Values
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 Activations

 Options

The tabs pane can be hidden to view a larger graph. To hide the tabs pane, click the Hide Selection link. 
To reveal the tabs pane, select the Display Selection link.

 
Select the desired actual value(s) under the Available Actual Values tab

The Available Actual Values tab gives you a list of values supported by the control unit. Select a value or 
multiple values to request the data from the control unit. Data sampling begins automatically.

The Activations tab provides an easy access point to activate vehicle components that the selected 
control unit manages. You can use the activations to affect the Actual Values data output, giving you 
truly comprehensive troubleshooting capabilities and greater ease of use. Read more about activations 
under the Activations section of this document.

Using the Activations tab, you can activate supported components

The Options tab provides access to editable settings of the Actual Values feature. 
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The Options tab provides access to editable settings

Options tab settings and controls include the following:
 Display Type

o Both digital and graph – shows data values in analog (graph) and digital format
o Digital display only – shows data values in digital format only
o Graph only – shows data values in analog (graph) format only
o Show multiple graphs – shows each selected value on separate graphs
o Show graph toolbar – opens a toolbar to aid in viewing graph details (see Graph Toolbar 

section below)
 Refresh Rate – controls the sampling rate of the program and helps balance the need for greater

detail with the available resources of the computer and control unit being sampled
 Export Data – used to export sampled data values to a Microsoft Excel®* spreadsheet or 

comma-separated values (CSV) file for further analysis
*Requires the Microsoft Excel application

 Other
o Stop / Start – controls sampling by stopping the process if it is running, or starting the 

process if it is not running
o Clear samples – clears previously sampled data values from memory
o Save settings – saves to an XML file the current settings based on the control unit 

selected
o Recall settings – opens a Browse window to select an XML file containing previously 

saved settings

The graph toolbar provides additional controls for use with Actual Values graphs. 

Actual Values graph toolbar

From left to right, the graph toolbar includes:

 Crosshairs – used to hover the mouse over a graph position to see the exact values of a point
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 Zoom in/out – used to alternately magnify or diminish an area of the graph to show detail. Left-
click and drag the mouse over the section you want enlarged.

 Zoom out all – used to zoom the graph back to full size

 Stop – used to stop sampling data values to view an event more closely

 Save – captures the current graph view to a graphic file

 Export data – saves sampled data values to a plain text file

 Page setup – portrait / landscape orientation settings for use with Print

 Print preview – displays preview of screen details to be printed

 Print – captures and sends a picture of the current graph to an available printer

Input Signals
Similar to Actual Values, Input Signals convey the status of monitored components of the car. Unlike 
Actual Values, however, Boolean values represent the status of Input Signals. For example, Input Signals 
will typically have values such as Open / Closed, On / Off, or Yes / No. Along with actual values, input 
signals can help you understand your car’s condition and help troubleshooting problems.
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Ready Status
Ready status, or “readiness,” is an indication by the car’s on-board diagnostics (OBD) of the status of 
several emissions monitors. Required on all USA cars since 1996, the readiness monitors check the 
emission control system and its components. If the emission control system is not “ready,” the car 
cannot legitimately meet emissions test standards. 

Several factors can cause a vehicle’s ready status to be “not ready.” Some factors include:
• Recent fault code clearance
• Recent battery disconnect
• A pending problem with the emission control system

To meet readiness conditions, you must drive the car through a specific drive cycle. The drive cycle 
varies by make and model and includes driving through a range of conditions, engine speeds, and loads. 
Check your service manual and local emissions requirements for details.

Activations
The Activations option allows you to start and stop supported components within the car for 
troubleshooting purposes. The tool supports components ranging from injection valves to windows and 
door locks. For example, to confirm all indicators of the instrument cluster function properly, you can 
use Activations for that control unit to turn them on for test purposes. 

To activate supported components:

1. Select your model.

2. Select a control unit that supports activations.

3. Select Activations.

4. Click the Start button found to the right of the components listed in the right-hand pane.

Warning! Use Activations options with caution and only with complete knowledge of their function. For 
example, it is not a good idea to activate the coolant shutoff valve of a hot car for risk of damaging the 
engine.

Coding
Available in the Professional kits only, the Coding option provides a way to back-up, restore, and change 
settings within supported control units. For example, you can save the settings of an old control unit you
must replace and restore those settings to a new control unit. Durametric relies on internal part 
numbers and metrics to ensure you do not restore settings to unintended, incompatible control units. 
Coding options on supported control units vary.

To backup control unit settings:

1. Select a model.

2. Select a control unit that supports coding.
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3. Select Coding.

4. Review the warning statement.

5. If you acknowledge the warning statement, click I understand the risks (proceed with coding).

6. On the Backup / Restore tab, click the Backup button. 

The Save As dialog appears. The program uses an XML file to save the backup settings. By default, 
the program names the file the same as the selected control unit and saves the file to the My 
Documents (or Documents) folder.

7. Save the XML. Note the save location and filename for future reference.

Save As dialog seen during Coding backup process

To restore saved control unit settings:

1. Select a model.

2. Select a control unit that supports coding.

3. Select Coding.

4. Review the warning statement.
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5. If you acknowledge the warning statement, click I understand the risks (proceed with coding).

6. On the Backup / Restore tab, click the Restore button. The Open dialog appears. 

7. Browse to the location of your backup files.

8. Select an applicable backup file.

9. Click the Open button. The program then restores the settings to the control unit.

To edit control unit settings:

1. Select a model.

2. Select a control unit that supports coding.

3. Select Coding.

4. Review the warning statement.

5. If you acknowledge the warning statement, click I understand the risks (proceed with coding).

6. Select the Coding tab. Editable options will appear.

7. Edit the settings as necessary. Settings changes take effect when you move the cursor to 
another field.

An example of the Coding dialog

Commands
Many control units support the ability to receive single, non-repetitive requests to alter the status of 
settings. Separate from coding changes, the Commands feature includes such control unit requests as 
adaptation resets. On many models, you will use the Commands feature of the Instrument Cluster to 
reset the service interval.

To use commands:

2/11/2025 ©Durametric Software Inc. Page 19 of 30



1. Select a model.

2. Select a control unit that supports commands.

3. Select Commands.

4. Click Send adjacent to command you want to send to the control unit.

 Click Send adjacent to the command you want to send to the control unit

Command Console
Available in the Professional kits only, the Command Console is a means to send low-level, manually 
configured requests to a control unit and see the response. Intended only for those who understand the 
low-level communication language of Porsche control units, you can use this feature for a deeper level 
of troubleshooting.

Reset Service Reminders
Late-model cars utilize service intervals and reminders on the instrument cluster for oil service and 
inspections. These cars display the reminder when service is due. You should reset service intervals upon
completion of the appropriate maintenance. 

To reset the service reminder:

1. Select your model.

2. Select the instrument cluster.

3. Select Commands.

4. Click Send next to the service interval option.
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Find service interval resets under the Commands option of the instrument cluster

Short Test
The tool is capable of running a short test on any model selected. The short test scans the car for 
supported control units and queries each control unit found for trouble codes. Upon completion of the 
scan, the program returns a list of control units included in the search and any faults found. The 
program groups the trouble codes it finds by control unit and includes a brief description of the fault to 
aid in troubleshooting.

To perform a short test:

1. Select a car model from the Choose Vehicle dialog.

2. Select any equipment variations.

3. Select the Functions menu option.

4. Click Short test all modules.

Set Workshop Information
Included with the Durametric Professional Kit only, you can customize the software for your business 
through the Set Workshop Information feature. With this feature, you can enter details such as your 
business name, address, phone number, and company logo. The information will appear on screens 
within the software and printed pages.
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To set workshop information:

1. Select the Functions menu option.

2. Click Set Workshop Information.

3. Enter shop name, address, phone number, path to your logo, and dealer code (if applicable). 

4. Select any of the available display options.

5. Click Save.

6. Close and re-open the program to affect changes.

Workshop Information edit screen

Work Log
The Durametric tool includes a work log that can save Identification, Information, Fault Code, and Short 
Test information. You can use this feature to review diagnostic and work history data after using the 
tool. The program saves work logs as HTML files so you can share the information with others as 
needed.

To Enable the Work Log
1. Open the Choose Vehicle dialog.
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2. Select a model.

3. Select the Create work log for this session option.

4. Click OK.

The program creates a work log using the date and time of the diagnostic session. The program creates a
separate work log each time you start the program.

To Review a Work Log
1. Select the File menu option.

2. Click Open Work Log.

3. Select a log from the list based on the date / time stamp.

4. Click Open.

When saved, work log files are marked automatically with a date / time stamp for easy reference. 

Updating the Software 
You can check for software updates direct from the Durametric program. This process requires an 
existing Internet connection.

To check for software updates:

1. Open the Durametric program.

2. Click on the Tools menu option.

3. Select Check for updates.

This action opens your default Internet browser to the www.durametric.com/downloadv6.aspx page. 
Compare the installed version on your computer with the current release indicated on the Download 
page. You will find your software version at the top of the Durametric program screen.

To update your software:

1. Close the Durametric program.

2. Uninstall the version of Durametric currently installed.

3. Click the Durametric Software Program link on the Durametric website. 

Updating the Cable Firmware
The standard interface cable manages communication between the Durametric software and your car’s 
control units. Periodically, Durametric releases firmware updates to ensure our cables continue to 
perform as expected across various models and software versions. 
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To update the firmware:

4. Click the Tools menu item.

5. Click Tool Information from the menu.

6. Click the Update Firmware button. 

Updating the firmware takes approximately 45 seconds. The standard interface cable must remain 
connected to the computer for the update to occur. Do not disconnect the cable during the firmware 
update.

Porsche Diagnostic Connector Locations
The location of diagnostic connectors on most cars is under the dash on the driver’s side. Here are some 
common connector locations:

 944/968 – Under the dash on the passenger’s side

 928 – Under the side cover of center console next to passenger’s seat

 964 – On the passenger’s side kick panel behind a round cover

 993

o 1994 – 1995 – For models with the 19-pin round connector, it is located on the 
passenger’s side kick panel behind a round, plastic cover

o 1995 – 1998 – For models with the 16-pin OBDII connector, it is located on the driver’s 
side of the center console behind a round, plastic cover

 986 / 996 – Under the dash on the driver’s side

 987 / 997 – Under the dash on the driver’s side

 981 / 991 – Under the dash on the driver’s side

 Cayenne – Under the dash on the driver’s side

 Panamera – Under the dash on the driver’s side

 Macan – Under the dash on the driver’s side

Factory Racecars
You can access information in Porsche factory racecars using the Durametric Professional Racing kit. Do 
to so:

1. Select a model (996 / 997).
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2. Select the appropriate Cup / RSR engine option.

The list of actual values for racecars covers most models, but not all actual values are available on all 
cars. There might be actual values listed in Durametric that the car does not support.

You can find the data link connector on racecars on the passenger’s side of the roll-cage. Porsche Cup 
cars before 2001 have a normal data link connector and do not need a special cable.
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Common Problems and Solutions
Here is a list of some common problems and solutions.

Software will not install  Confirm you have an internet connection
 Confirm your computer meets the minimum system 

requirements
 Confirm there are no software installation 

restrictions at the firewall
 Confirm you have appropriate rights to install 

software (especially important on Windows Vista)
 Install (re-install) Microsoft .NET Framework 2.0 or 

3.5 sp1
Software will not start  Restart your computer

 Confirm your computer meets the minimum system 
requirements

 Reinstall the software from www.durametric.com 
Cable not recognized by the 
software

 Confirm Windows Device Manager “sees” the cable 
when connected

 Confirm Durametric USB cable drivers are installed 
 Confirm the cable is a genuine Durametric cable

Initialization failure when trying to 
connect to a control unit

 Cable is not securely connected
 K-line short to ground or Battery+
 CAN bus has entered “sleep” mode (MY2005+)
 Control unit is faulty
 Control unit not present
 Control unit is different than the one selected in the 

Durametric software
 Control unit not properly supported – contact 

technical support
Cable LED turns red  Indicates an electrical short

o Between K1 or K2 and B+
o Between K1 or K2 and Ground

 Check for appropriate continuity between the 
ground, power, and communication pins at the 
diagnostic connector at the car

 Check for electrical shorts by clicking Tools  Tool 
Information when connected to the car

Cable LED won’t turn green  Confirm there is a secure connection between the 
Durametric cable and the car

 Confirm the car’s ignition is in the ‘on’ position
 Confirm the car’s battery is fully charged or a back-

up power supply is correctly attached
 For CAN bus based cars, awaken the CAN network by

switching the key to ‘off’ and then to ‘on’. Confirm 
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the check engine light appears on the instrument 
cluster display. Keep the CAN bus ‘awake’ during 
diagnostics by turning on the emergency flashers

 Check for appropriate ground (pins 4 & 5) and 12+ 
Volts (pins 1 & 16) at the diagnostic connector of the
car when the ignition is on

“Cable not plugged in” message  Confirm the cable is securely connected to the USB 
port on your computer

 Confirm there is power from the car to the cable and
the LED on the cable is steady green

 Confirm Durametric USB cable drivers are installed 
properly – reinstall cable drivers if necessary

 Confirm Windows Device Manager “sees” the cable 
when connected

 Confirm the cable is a genuine Durametric cable
Cannot update the software  Confirm there is an update available

 Confirm you have an internet connection on the 
computer that runs the Durametric software

 Confirm you have the appropriate administrative 
rights to install software

 Uninstall Durametric through the Windows Control 
Panel and reinstall USB Cable Drivers and Durametric
Software Program from www.durametric.com

Module “failed to initialize”  Confirm the cable is securely connected to the car 
and computer

 Confirm the control unit exists in the car
 Wiring problem in car to control unit (very common 

in the 993 at the data link connector)
 Electromagnetic interference:  Confirm all stereos, 

radar detectors, navigation equipment and 
amplifiers are turned off while performing 
diagnostics

 Computer processer is too slow: See Computer 
Performance Suggestions in this guide

Computer Performance Suggestions
Control units fitted to newer cars communicate at a fast 500 kbps (kilobits per second) and require 
timing windows as small as 5 milliseconds. In this case, some computers might experience difficulty 
connecting.  Here are some suggestions to help improve the performance of your computer:

 Confirm the computer meets the minimum requirements for processor speed and memory (1.8 
GHz dual-core processor or faster and 1 GB of RAM)

 Close all other programs during diagnostics

 Remove any CD / DVD from CD or DVD drive
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 Connect laptops to power or change Power Management settings to maximum performance. 
Most laptops will run at reduced processing speed when running on battery power.

 Defragment the hard disc. When your hard disc is heavily fragmented, the computer must work 
harder and therefore, runs slower.

 Temporarily disable anti-virus software. Some virus protection software can slow or stop the 
communications ports.

Send Log to Durametric
Use this option only upon direct request of Durametric technical staff. Durametric does not respond to 
unsolicited communications logs.

When working with Durametric technical staff, they may ask you to submit troubleshooting logs via the 
Send Log to Durametric option. You will find this option under the Tools menu. An Internet connection is
required to send the information to Durametric.

To send a communications log to Durametric:

1. Click Tools | Logging | Enable Logging.
2. Restart the program.
3. Perform any processes or functions previously found to fail. This ensures the program captures 

the communication details between the program and the car. 

4. Select a log from the list. The program lists the logs in chronological order, based on the time of 
creation.
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5. Enter your name, email, and details about the car. Be sure to include a detailed description of 
the problem.

6. Send the log by clicking Send Data.
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